Single Electricity
Market Operator

Download, Install, Export or Import a VeriSign Production Digital
Certificate for Market System Access



Table of Contents

DOCUMENT CONTROWL .o e e rnr s

. DOCUMENT HISTORY oottt e e e e e s s s bbb et e e e e s 1o b b e e e e e e s s s b e e e e e e e e et bbb e e e e e e s s sab e s e e e e e s s sbbbaeenas
s OBUIE CTIVE oot e e E e e e e e e e e s oL e e e e e e e s e e e e s e e s e e e e e s s e e e e e e e s
. OBTAIN AND INSTALL VERISIGN PRODUCTION DIGITAL (PRIVATE) CERTIFICATE ..c..cccoiiiiiiiiiiii,
. CHECK THE LOCATION/INSTALLATION OF YOUR NEW CERT ...oiiiiiiiiiiciii e
. EXPORT VERISIGN PRODUCTION DIGITAL (PRIVATE) CERTIFICATE ..ot
. IMPORT VERISIGN PRODUCTION DIGITAL (PRIVATE) CERTIFICATE ...ii it

o 0o A W N P

APPENDIX 1. DOWNLOAD CERTIFICATE USING TELL ..ot 15



DOCUMENT CONTROL

1. DOCUMENT HISTORY

Version Date Author Comment
1.0 14/01/2013 SEMO
2.0 09/01/2014 SEMO

2. OBJECTIVE

This document outlines the steps to take to:
1) Obtain and install your Verisign Production Digital (Private) Certificate
2) Check the location/installation of your cert

3) Export your Verisign Production Digital (Private) Certificate

3. OBTAIN AND INSTALL VERISIGN PRODUCTION DIGITAL (PRIVATE)
CERTIFICATE

Please note digital cert should not be downloaded via Citrix connections.

1) Ensure that you have been issued with your Passcode Information as this is
required to download your Verisign Production Digital (Private) Certificate - or
simply Digital ID. When you are issued with this information you will be given
your Passcode, First Name and Email

2) Browse to:
https://onsite.verisign.com/services/EirgridAIME/digitalidCenter.htm

3) Click the ENROLL link to access the following page:



a Microsoft end-user Enrallment - Microsoft internet Explorer provided by ABB : 'ﬁ
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Enrollment

Complete Enrollment Form

Enter your Digital ID information

Fillin all required fields. Fialds marked with an asterisk {(* ) are includad with
your Dugtal 1D and are wiewable in the certhcate's delails

First Name: *  (qurea)
Mickname or medde imba alloved
[Eample. Jack B.)

Passcode:  {roquind)

Challenge Phrase

The Challangs Phrasa is 3 uniqus phrasa that protacts you against
unauthorized action on your Digital ID. Do not share itwith anyones, Do not
Joser it You will need it whan yiou want i reviake or renew your Digital 1D

Enter Challenge Phrase:
Crecuird)
Do nat use any punchuation

Optional: Enter Comments

In some cases. vour administretor will instruct vou to enter Shared Secret
infarmatian (known only to you and the administrator) n this field. The
administrator uses this shared secret 1o venfy that it really is you submiting the
application. This comment will not bé included inwour Digital 10

S ——

4) Complete the First Name (e.g. MAIN_USER@PT_xxxxxx)and Passcode fields
(using the information received via email)

5) Choose a suitable value to complete the Enter Challenge Phrase field - please

make a note of this as it will be required should you need to re-download the
certificate.

6) Click the green Submit button when all 3 fields have been populated.

7) When issued with the following prompt click Yes.

Potential Scripting Violation

1 This Web site is requesting a new certificate on your behalf, You should allow only trusted Web sites to request a certificate for you,
. Do you want to request a certificate now?

8) When issued with the following prompt click OK



Creating a new RSA exchange key E‘

An application iz creating a Protected item.

CryptodPl Private Key

S&Gu"ty I&Vel set to Medlum [ Sel‘ﬁecu[ity Level_“ ]

b 0k W Concel JH Dotnis.. |

9) When issued with the following prompt please click Yes

Potential Scripting Violation

A\

This ‘Web site is adding one or more certificates to this computer. Allowing an untrusted Web site to update vour certificates is a security risk. The Web
site could install certificates wou do nat trust, which could allow programs that vou do not Erust to run on this computer and gain access ko your data.

Do you want this program to add the certificates now? Click Yes if you trust this Web site, Otherwise, click No,

10) You will receive a success message as below — Your digital cert is now

installed.
Vessicr  Digital ID Services
Congratulations!

Yaur Digital ID has been successfully generated and installed.
nmr Digital I Informatinn.

Fmal ddmes = daw d.Angliseirgrd.<rm
Cocmmon hlame = CENCLISH B2 IMSER
Qigariicelivr = L[ME
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4. CHECK THE LOCATION/INSTALLATION OF YOUR NEW CERT

To check that your new Digital ID is installed in your browser as follows:
1) Open Internet Explorer

2) Click Tools > Internet Options > Content > Certificates
3) Click Personal tab - you should see an entry as below

Intended purpose: _ <hll= |

Personal | Other People | Intermediate Certification Authorities | Trusted Root Certificatior ¢ *

Issued To Issued By Expiratio...  Friendly Name A
@ AIPMOR@AIPSEM EM-DVAWDL 25/05§2008  <MNone:
AIPMOW@AIPSEM EM-DVAWDL 25J0552008  <MNonex
F\IPMOW@AIPSEM EM-ITAWO1 02/04/2008 <Mone>
AIPMOW@AIPSEM EM-PRAWD1 29J05/2008  <MNone=
ES DEMGLISH@AIPSEM  AIME - contractual joi...  13J08/2008 <Mones>
Eleoazie Post.Trusk Operation...  07J05/2007 <Monex
E[F\_NIMOTLEDI@IP.. . EM-ITAWDOL 02/04/2008 <Mone>
@ [A_RIHOYLE_1@IA.., EM-ITAWO1 02J04j2008 <MNone=
[Ema_test1 AIME - TEST contract...  28/06/2008 <Mone> v

[ Import... H Export... }[ Remove: l

Certificate intended purposes

Client Authentication

4) Check that the Issued By field reads: AIME - contractual joint venture
between Eirgrid and SONI.

5) The Expiration Date field should read the current date plus 1 year.

6) Click on the Intermediate Certification Authorities tab and confirm the
list has been updated as follows: xxx



5. EXPORT VERISIGN PRODUCTION DIGITAL (PRIVATE) CERTIFICATE

This process is to be followed should you want to use your digital cert on a different
computer, or if you wish to ‘Sign Data’ in the Market Participant Interface.

1) Open Internet Explorer
2) Click on Tools, Internet Options
3) Click on the tab Content
4) Click on the button Certificates
5) Click Personal tab
6) Select your digital cert and click the Export button
Certificates
Intended purpose: <all=
Personal | Other People | Intermediate Certification Authorities | Trusted Root Certificatior € *
Issued To Issued By Expiratio,..  Friendly Name =
Elapmor@alpsem EM-DVAWD1L 25/05/2008 <None>
Elarrmow@alpPsem EM-DAAWOL 25/05/2008  <None>
Elatpmow@alrsem EM-ITaW01 02/04/2008 <MNone>
Elatpmow@aIPSEM  EM-PRAWDL 20/05{2008  <None>
B DENGLISH@AIPSEM  AIME - contractual joi...  13/08/2008 <None:
Eleonazis Post, Trust Operation..,  07/05/2007  <Mone:
Ela_nmovLlEoi@Ia.., EM-ITAWD1 02/04/2008  <None>
Ela_pHovIE_1@I4.., EM-ITAWDL 02/04/2008  <None>
ma_testl AIME - TEST contract,., 28/06/2008 <Mone: v

RIX

’ Impott, .. H Export...

H Remave ]

Certificate intended purposes

Client Authentication

s

7) Click the Next button from the following screen

Certificate Export Wizard @

Welcome to the Certificate Export
Wizard

This wizard helps you copy certificates, certificate trust
lists and certificate revocation lisks from a certificate
store ko your disk.

& certificate, which is issued by a certification autharity, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections, A certificate store is the system area where
certificates are kept.

To continue, click Next,

Coma ]




8) Click the following option and click Next

Export Private Key
‘You can choose to export the private key with the certificate.

Private keys are password protected. If vou wank to export the private key with the
certificate, wou must bype a password on a later page.,

Do you wank ko export the private key with the certificate?

Yes, export the private key:
es, exp Pri Y

Mo, do not export the private key

[ < Back JI Mext = I[ Cancel J

9) Ensure that you select the following options and click Next

Certificate Export Wizand

Export File Format
Certificates can be exported in a variety of file Formats.

Select the Format you want to use:
DER. encoded binary %509 (.CER)
Base-64 e ed ¥.500 {,CER
Cryptographic Message Syntax Standard - PKCS #7 Certificates (.P7B)

Include all certificates in the certification path if possible

(&) Personal Information Exchange - PKCS #12 ( PFX)
[“linclude &l certificates in the certification path if possible;

[*] Enable strong protection (requires 1E 5.0, NT 4,0 SP4 or ahove)

[ ]Delete the private key if the export is successful

X

[ « Back ]l Mext = I[ Cancel

]




10) Specify a password as below and then click the Next button

NOTE - You will need to remember this password for use in the MPI

Certificate Export Wizard @

Password
To mainkain security, you must proteck the private key by using a password.

Type and confirm a password.

Password:
|*****

Confirm password:
|******

[ < Back " Mext = I[ Cancel J

11)Please specify the File Name as below
To avoid confusion this File Name should match the “Issued To” field of the
Digital Certificate e.g. DENGLISH@AIPSEM or JBLOGGS@PT_xxxXXX

Certificate Export Wizard @

File to Export
Specify the name of the file you want to export
File name:
[ < Back ” Next > I [ Cancel ]

12) Click Browse and save the digital cert to your Personal drive or to a USB
stick - click Next
13) Click the Finish button to complete the export

6. IMPORT VERISIGN PRODUCTION DIGITAL (PRIVATE) CERTIFICATE



Follow the process below to import a certificate into your internet browser
(Alternatively you can double click on the certificate saved on your local drive and
follow the instructions from step 7 onwards):

1) Open Internet Explorer

2) Click on Tools, Internet Options
3) Click on the tab Content

4) Click on the button Certificates
5) Click Personal tab

6) Click Import

Certificates

Intended purpose:

Personal | Other People | Inkermediate Certification Authorities | Trusted Root Certificatior ¢ *
Issued To Issued By Expiratio...  Friendly Mame

Certificate intended purposes

Close

7) Click the Next button from the following screen

10



X
Welcome to the Certificate Import
Wizard

This wizard helps wou copy certificates, certificate brust
lists, and certificate resvocation lisks From your disk to a
certificate store,

A certificate, which is issued by a certification authority, is
a confirmation of vour identity and contains information
used to protect data or ko eskablish secure network
connections. & certificate store is the svstem area where
certificates are kept,

To continue, click MNext,

I MNexk > J [ Cancel l

8) Click Browse and navigate to the copy of your certificate on your local drive
Certificate Import Wizard EJ

File to Import

Specify the file you wankt ko impart.

File name:

Browse. ..

Mote: More than one certificate can be stored in a single File in the following Formats:
Personal Infarmation Exchange- PKCS #12 {.PFx, P12}
Cryptographic Message Syntax Standard- PKCS #7 Certificates (P7E)

Microsoft Serialized Certificate Store (.55T)

[ < Back “ Mext = I[ Cancel

Note, change the Files of Type selection to All Files (*.*)



Click Next

9) Enter the password you specified when exporting the copy of the certificate

Open X
Look in: |@ Dresktop v| ) T = -
L @My Documents
4 :} My Computer
My Recent I killralicy
Documents 12 Audio Files
- 1) Audit 2013
=
H L%} IL2)5MP Checks
Desklop WOICE

My Documents

ty Computer

by Metwork

File name: | v | [ Open

l

Files of type: |><_509 Certificate (*.cer.”.crt] v| [ Cancel ]

[>. 509 Cerificate *.cer:*.crl

Certificate Import Wizard

File to Import
Specify the file you want to import,

File: name:

[n\Documents and SettingsiPlunkett_\Desktop! Test.pfx | [ Brawse. ..

Mote: More than one certificate can be stored in a single file in the following Formats:
Personal Information Exchange- PKCS #12 (. PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates { P7E)

Microsoft Serialized Certificate Store (L55T)

X

[ < Back ][ Mext = ][ Cancel

]

10)Click *Mark this key as exportable...’

11)Click Next

12



Certificate Import Wizard

Password
To maintain security, the private key was protected with a password.

Type the password For the private key,

Password:
|********

[[]Enable strong private key prokection. Wou will be prompted every time the
private key is used by an application if vou enable this option.

Mark this kew as expaortable, This will allow wou bo back up or transport wour
keys at a later time.

< Back ” Mext = ]l Cancel

12) Click ‘Automatically select the certificate store based on the type of
certificate’ and click the Next button

Certificate Import Wizard fg|

Certificate Store
Certificate stores are system areas where certificates are kept,

Windows can autormatically select & certificate store, or you can specify a location For

() automatically seleck the certificate store based on the bvpe of certificate:

(") Place all certificates in the Following stare

< Back ” et > ][ Cancel

14) Click Finish



Certificate Import Wizard

Completing the Certificate Import

Wizard

‘ou have successfully completed the Certificate Import

wizard.

‘fou have specified the Following settings:

Certificate Store Selected  Automatically determined by

Cankent
File: Mame

PFX

[:h\Docurments and SettingsiP

x

[ < Back ”

Finish

I [ Cancel

15) Close & Reopen a new Internet Explorer session

16) Navigate to the MPI ..

14



APPENDIX 1. DOWNLOAD CERTIFICATE USING IE11

IE8 is the only browser certified for use with the Central Market Systems. SEMO are
unable to provide support or assistance if you are using a browser other than IE8. If
you experience issues having downloaded a certificate in a browser other than IES,
please contact the market helpdesk and the certificate can be revoked and a
passcode re-issued for the certificate to be downloaded in IES8.

In the event that you need to use IE11 to download a digital certificate, please follow
these steps. Please note that SEMO are unable to provide support or assistance if
you are using a browser other than IE8 - The following steps are for
informational purposes only.

1. Load the digital certificate website by clicking on the link supplied by the
Market Helpdesk

2. Click on the Tools icon and select Compatibility View Settings.

Print »

File »
Zoom (100%) »
Safety »
Add site to Start menu

View downloads Ctrl+)

Manage add-ons
Go to pinned sites
| Compatibility View settings |

Internet options

About Internet Explorer

15



3. Add the Verisign.com site to the Compatibility View Settings

e 4 https://onsite.verisign.com/services, A gitalidCenter.htm £ - @ 0| 4 Digital D Center I

Vomanse | Digital ID Center
=] 5
Eirgrid AIME Digital ID Center

< ENROLL Compatiity View Settings =

Choose this option to enroll for a client Digital ID

[ Change Compatbiity View Settngs

PICKUPID

Choose this oplion if you enrolled for a Digital ID but did not pick it up Add this website:

SEARCH

Choose this oplion to search for a Digital ID. This function is useful for determining whether verisign.com —
a Digital ID is valid. expired, or revoked. You may also downlead IDs from this option

@ RENEW

Choose this option to renew a Digital ID which is expiring or which has already expired. You
should generally start renewing your Digital ID at least one month before your Digital ID is
due to expire.

Websites you've added to Compatibility View:

Choose this option to revoke your Digital ID. Digital IDs should be revoked immediately for
any suspected compromise, including lest or stolen private keys, corrupted key pairs, [ use Mrosoft compatbity lists
change in site ownership, or suspected fraud

Display intranet sites in Compatibility View

Learn more by reading the Int=rnet Explorer privacy statement

(W) INSTALL CA

© 2002, Symantec Corporstion. All rights reserved J Syrnantec_

4. Refresh the webpage and follow the instructions provided to download your
digital certificate.



